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INTRODUCTION 
The Management Suite of applications allows you to use your PC to 
graphically create multiple ringing schedules, synchronize the clock, back up 
schedules and settings and keep the operating system up to date. In addition, 
new versions of our systems feature advanced capabilities that would add 
complexity to the easy to use front panel menus. These capabilities are 
unlocked in the applications that are provided in the Premium version of the 
software. 

In order to properly configure all features of this software, your system should 
be connected the first time you run Management Suite. Please follow all 
installation and connection instructions below before attempting to use this 
software. 

INSTALLATION 
If you ordered the Premium version of this software with your Chime Master 
product, your package should have included an installation disc, this manual 
and a USB cable.  

Do not connect the Chime Master unit to your PC until the software has 
been installed from the CD. This will allow device drivers to be properly 
registered for your system. 

System Requirements 

Management Suite is fully compatible with computers running under 
Microsoft Windows versions 2000 to 8 (not RT). It is also compatible with all 
Chime Master products that have a USB port. A firmware update may be 
needed to get certain applications to work, and a copy of the latest firmware is 
supplied with the software (for systems supporting USB firmware updates). 

After you have finished installing the software, and run it for the first time, 
click the Update Firmware menu button to update your Chime Master 
product. 
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Installation Guide for Windows XP 

1. Insert setup disc into your computer.  If Autorun does not proceed, click 
Run on the Start menu and enter <CD drive letter>:\setup.exe. 

2. Open the installation file setup.exe if not automatic 
3. The installer will guide you through the process.  Click Next. 
4. License Agreement must be read and “I Agree” selected in order to proceed. 
5. Click Next, observe selectable contents to be installed, and click Next. 
6. Choose shortcut options and click Next. 
7. Select install location and users if defaults are not desirable.  Click Next. 
8. Click Next to begin installation.  It should take no more than a minute to 

finish. 
9. If install is interrupted by Windows Logo warning, click Continue Anyway. 
10. After successful completion, click Close. 

 
Optionally configure Windows XP Firewall for use with mobile apps: 

1. Open Firewall settings by holding the Windows key while pressing R, then 
type firewall.cpl (enter). 

2. Click the Exceptions tab, click the Add Port button and enter "Chime 
Master Remote" and 6777 for the port number, and make sure TCP is 
selected. 

3. Click OK to create the exception. Click OK to close Windows Firewall. 

Installation Guide for Windows Vista/Windows 7/8 

Installation is similar to XP above. If you have issues running under Vista or 
Windows 7, try this workaround: 

1. Right click on any Management Suite icon, shortcut, or Start.exe (from the 
installed directory). 

2. Choose Properties and click the Compatibility tab. 
3. Check the “Run this program as an administrator” box under Privilege 

Level. 
4. Click Apply and then click OK. 

Optionally configure Windows Vista, 7 or 8 Firewall for use with mobile apps: 
1. Open Firewall Advanced settings by holding the Windows key while 

pressing R, then type wf.msc (enter). 
2. Click "Inbound Rules" in the left column of the window. Select Rule type 

"Port" then click Next. 
3. Select TCP and type 6777 for the specific local port and click Next. 
4. Select "Allow the connection" and click Next. 
5. Type "Chime Master Remote" for the name and click Finish 
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Connecting to the Chime Master System 

Using a standard USB cable, connect the smaller, square connector to the 
back of the rack mounted unit or bottom panel of the wall-mounted bell 
controller, and then connect the rectangular end to your personal computer. 
Whenever connecting or disconnecting this cable, Management Suite should 
be closed. 

Windows usually displays the New Hardware Wizard once the connection is 
made. After a successful installation of the software and drivers, select 
automatic installation for the driver. This will occur each time a different 
system is connected to the computer. If a notice concerning Windows Logo 
testing pops up click “Continue Anyway.”  After it is done loading, click 
“Finish.” 

If the driver does not load automatically, disconnect the control head and try 
opening [MillDriverInstall.exe].  The default driver location is: 

C:\Program Files\Chime Master\Millennium Suite\MillDriverInstall.exe 
After a successful installation, locate and open the Management Suite from a 
shortcut or from a program menu.  If the connection between computer and 
bell system is detected, a “Ready” status will be displayed at the bottom of the 
menu panel. 

Synchronizing Titles 

Press the Remote Control button to test the connection between the bell system 
and the PC. You should see on your PC screen the same display that the 
control head shows. Close the remote control window. 

The Jukebox and Scheduler applications will be easier to use if the PC has the 
titles from your bell-ringing library. Press the Jukebox button on the menu 
screen. From the Jukebox menu, select Titles then Get Device Titles. Press OK 
to confirm. You will see in the bottom status bar the progress of the title 
transfer process. In about a minute you should see your library titles in the 
right pane of the Jukebox window. Close the Jukebox window. 

If your system schedule has been set up and programmed, but has not been 
backed up to this PC yet, press the Backup menu button. Follow the 
instructions on page 31 to back up your system setup memory.  



MAIN MENU 

 
Management Suite (Free download) - Main Menu Panel 

The Premium Management Suite will show a few more buttons than are 
shown above. Added features will be marked in the manual as pertaining to 
Premium Management Suite Only. 

Other information pertaining to the connected bell system will be displayed 
in the upper right-hand box. These may be requested by a customer service 
representative if you call for technical support. You can hide this box by right-
clicking on the panel and de-selecting View-Details. 

M = Model L = Library Catalog Version  
F = Firmware Version  D = Clock Dial interface option 

Menu Customization 

Right clicking your mouse in the button area of the main menu allows you to 
customize the menu. You can hide the details panel displayed on the right of 
the window, resize buttons and hide buttons you don’t use. The default 
button sizes are handy for a touch screen, but feel free to make them smaller 
if you always use a mouse.  
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 Some features require the bell control head to enter a dedicated 
communications mode called USB Slave Mode. Switching between slave and 
normal modes may cause the controller to reboot, resulting in a minute delay. 
The status bar at the bottom of the application screens indicates the current 
mode of the controller. If your computer is not next to the Chime Master 
where you can see the screen, watch the bottom stat 

Always make USB connections to the controller before starting Management 
Suite. Allow a few seconds after connecting for the drivers to load. 

Leaving Management Suite Open 

These features depend on you leaving the Management Suite main menu 
open: 

 Church Bell Remote Mobile App 
 Daily Time Synchronization to the Time Server 

If you wish to use these features, leave the menu open and lock the computer 
rather than logging out to prevent unauthorized access. You should set your 
power settings to prevent the computer from sleeping or automatically going 
to standby after a period of inactivity.
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PREMIUM SETTINGS 
Upgrading from Free to Premium Features 

If you find that you need more features than the Free download provides, 
call us for the price of a Premium License. There is no limit to the number 
of computers you are allowed to install the software license to. If you have 
already purchased the license, the license code will be on the packing slip 
that accompanied your system. To enter the License code to unlock all of 
Management Suite’s features follow this procedure: 

1. Open the Management Suite menu on your PC.  
2. Right-click over the menu window and select Licensing. This will 

open a new, smaller window which prompts you to enter a License 
Key.  

3. If we have emailed your key to you, highlight the Key in your 
email and right-click to copy it to the Windows clipboard. In the 
small Management Suite window, click Paste from Clipboard and 
the Key will be entered. 

4. You can also enter the key from the packing slip or printed email. 
5. Continue as prompted to exit and restart Management Suite. 
6. You should see additional menu buttons. 

Administrator Panel 

Root Directory 
This directory defaults to the user's My Documents directory for storing 
Millennium Suite files for backups and schedules. If several users login to the 
PC to schedule the bell system, they will not be able to access files saved by 
other users. You may also wish to use a network server to store your files on, 
and this can be specified here. This works best if the network directory is 
mapped to a drive letter.  

Network Time Server 
Normally the default time servers work for the time sync function. If you do 
not have Internet access on your network or prefer to use your own server, 
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enter its address and port (typically 123) and select if it uses the NTP or NIST 
protocol. 

Mobile App Host 
The Administrator panel is also used to set up the host for mobile apps. Before 
setting up your mobile app, be sure that you have downloaded the latest 
Management Suite and updated the carillon firmware after installing the 
software. Also be sure to configure the Windows Firewall for use with the 
remote app as described on page 6. 

To enable the host server for the mobile app, make sure the check box “Run 
host at startup” is checked. The app host will automatically start the next time 
you launch Management Suite. Write down the Address and Port shown on 
the Administrator Panel. You will need to enter them into the mobile app. 

Click the User Accounts button in the Administrator window to add a 
mobile user and assign access rights. Keep in mind while you set user names 
and passwords that you will need to use the mobile keyboard to enter them 
into the app later. 
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Configuring Church Bell Remote Mobile App 

Download and install the Church Bell Remote app from the Play Store or 
App Store. You can easily find it by searching for Church Bell Carillon. 
Connect your mobile device to the church Wi-Fi connection. The Wi-Fi 
access point needs to be on the same LAN as the PC running Management 
Suite for them to be able to connect. 

Start the Church Bell Remote app. You will see a warning that a host has not 
been set. Touch OK and then touch the Settings menu button. Touch the 
Host menu item, then the Add button on the top right corner of the Hosts 
screen. Enter the name of the church in where the Add Host screen asks for 
Name (St John Wi-Fi), the App Host address displayed in the Management 
Suite panel, and then make sure that the Port is set to the same value. Tap the 
Ok button at the bottom of the screen. Tap the Settings button to back out to 
the settings menu, and then Close it. 

If you create entries in the Hosts list you wish to delete, press and hold them 
for the delete menu. 

When the app connects to the host PC you will be prompted to enter the 
User Name and Password that you set up in the User Accounts 
Administration window above. Tap Log In and you should be able to ring 
your bells. 

For additional information, read the online help file accessible from the 
mobile app settings menu. 

Error Messages 
Host Suspended - You cannot control the bell system when someone else is 
locally using the Management Suite on the host PC. Return the Management 
Suite to the Main Menu window. 

Firmware Update Required - The firmware version in the carillon does not 
support the remote app. Compatible firmware is distributed with the 
Management Suite, which us used to perform the update. 

Error Communicating - The app can reach the Management Suite host, but is 
not receiving status from the carillon. Check the USB connection and restart 
the Management Suite.
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Host may not be running - The app is not able to reach the Management 
Suite host system. 

 Did you correctly enter the IP address of the host PC? 
 Is the host PC running? 
 Is the Management Suite running? 
 Double check that your mobile device is on the same Wi-Fi network as the 

host PC. 
Connection attempt timed out - This generally involves the firewall(s) 
ignoring incoming connection requests. 

 Did you set up the port exception in Windows Firewall? See Installation 
guide on page 6. 

 Are other router firewalls preventing access? 
 If you are trying to access through the public Internet with a slow 

connection, try increasing the Connection Timeout in the app settings. 
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SETTINGS 
Edit Remote Buttons 

When the system is in Standby mode (not playing, displaying the current 
time), buttons 1 through 8 can be programmed to manually trigger selections 
to play. Buttons 1 through 4 are available on the optional mini remote 
control. All eight buttons are available to the mobile app Church Bell Remote. 
In addition, all eight button programs correspond to macro codes 7901 
through 7908. You can use these macro selection codes to schedule automatic 
play of the selections programmed in the buttons. 

Pull down the button code you wish to 
program F1 through F8 in the left field. The 
programs shown indicate the last program you 
entered, or the default settings, not necessarily 
the settings currently set in the controller for 
the button. 

To see what program is currently set for the 
each button, click Get Function from Device after 
selecting the button with Fn pull down. After 
you have edited the changes, click Put Function 
into Device to transfer the settings to the 
controller. 

Buttons 1 through 4’s four-character (short) name are displayed on the lower 
line of the carillon’s display. These can be edited in the field to the right of 
the button pull-down selector. The Church Bell Remote mobile app uses the 
first two characters of all eight button’s short names to determine which icon 
to display for the function’s button. The Mobile App Label allows you to give 
the function a more meaningful long name that will display beneath the 
button in the mobile app.  

Synchronize Clock 

The internal bell system clock can be synchronized to internet time servers 
using the time zone you set in Windows on the host computer. If the 
checkbox for Automatically Synchronize Date and Time is selected, the time will 
set every day if the Management Suite is running and left at the main menu. 
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Manual synchronizing can be done by clicking the button on this settings tab. 
If your network does not access the Internet and you have your own time 
server, the Premium Management Suite’s Administrator options allow you to 
specify the time server’s address. 

Time Strike Melody 

Millennium bell controllers are not limited to the 
Westminster chime for clock striking. Use the p
down menu to select the melody you would like to
use. If you select User Sel Strike, you can enter 
selection numbers into the four fields for each 
quarter. Any valid selection number will work. 
you have the recording librarian, you can even 

play your own clock chiming melody on the keyboard Note that appro
melodies must be chosen for the number and sizes of your available bell

 

ull 
 

If 
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SCHEDULER 
With the scheduler, you can view, edit, and save multiple weekly schedules to 
your personal computer.  A schedule can be loaded into your bell control 
system at any time.  

The text editing modes are useful for programming non-time strike events like 
Angelus and call to worship bells. The graphical modes are the best way to 
program time striking for certain times of the day. 

Review the Weekly Schedule 

On the main Management Suite menu, click the Scheduler button to open this 
application. A standard menu bar is located at the top of the window.  Use 
the File menu to open and save schedules to your hard drive. Use the Edit 
menu to open additional panels for schedule editing and the Device menu to 
transfer data between the PC and the controller. Data transfer can only be 
accomplished when the controller is connected to your computer via the USB 
interface. Toolbar buttons can be used instead of the pull-down menus. 

 
Change Timeslot(s) – Graphic Mode Get Titles from Device 

 

 

 

Open Last Known Device Schedule Save All 
Put Schedule into Device Open Schedule 

Change Timeslot(s) – Text Mode 
New Schedule Get Schedule from Device 

Open Last Known Device Titles 
Save  

 

Scheduler toolbar 

To open and view a schedule,  

1. Select New Schedule from the file menu for a blank schedule, or 
2. Select Open from the file menu to review a previously saved schedule, or 
3. Select Get Schedule from Device from the Device menu to see the current 

schedule. Detailed instructions for this are on page 23. 
Filter the Schedule Listing 
Click the right mouse button in the empty space of the schedule to set 
filtering options to view all time slots, slots with time-strike options, or times 
with other events programmed. 
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Schedule with Calls to Mass and Angelus Ringing 

 
The schedule window lists the day, time slot, time strike mode, and selections 
for each quarter-hour of the week. Multiple schedules can be open at a time 
in the tabbed window viewing environment. It is a good idea to name and 
save your file when starting a new schedule and to save often.   

Creating and Editing Weekly Schedules 

The schedule data is predominant in the Scheduler window and is used to 
select certain timeslots or view the current schedule file.  It is important to 
remember that the schedule you are working on is not loaded and active in 
the controller’s schedule memory until it is put there (see Uploading Schedules 
to the Controller on page 21). Keep in mind that someone else may have edited 
the schedule on the controller since the last Scheduler file was uploaded into 
it. 

A good habit to get into might be to get the active schedule (described on 
page 21) from the controller and save it as “backup-(today’s date)” before 
making changes to it. 
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Daily schedule editing in text mode with title lookup. 

Selections 
You will notice four sets of “0000” for every quarter-hour under Selections in 
a new schedule listing.  These are fields that hold selections for anything 
other than time strike programs. If you are entering a specific bell ringing 
operation, the selection number is entered directly into the selection field. 

If you don’t want to begin ringing on the quarter-hour, a pause macro can be 
programmed to delay the beginning of the program. Pause macro codes are 
on the pull-down menu in each selection field. For example if you want to 
ring a swinging bell at 8:55, program an eight-minute and then a two-minute 
pause before the ringing code in the 8:45 time slot. 

To erase a selection in the text edit mode, choose the blank selection from 
the pull-down menu, or enter four zeros.  

Text Mode Editing Panels 
Click the Change Timeslot(s) – Text Mode tool bar button or select it from the 
Edit menu. A window will open with a panel that allows you to change one 
time slot. Tabs at the top of the window allow you to select other methods of 
setting the time so that you can program multiple days, a range of time or 
only those time slots that you have selected in the schedule viewing window. 

Although you can program changes to the time striking in the text mode 
editing panels, it is easier to do that in the graphical editing mode described 
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below. When you open a text mode editing panel the check boxes for level 
and time strike changes are unchecked to prevent unintended changes.  

Selections may be programmed in the lower portion of the Edit Change 
Timeslot – Text Mode editing panels. Up to four selections can be entered per 
time slot from left to right. To enter a numeric selection, click your mouse in 
the selection window and then type the four digit selection number. The 
cursor will advance to the next selection window after you make the entry. To 
program macro codes for pauses use the drop down button next to the 
selection window, and select the code.  

To erase selections you have entered, use the pull down button to select a 
blank entry. You should do this from right to left because the editing panel 
does not allow blank selections between programmed selections. 

Add new events to the weekly schedule 
Click the Change Timeslot(s) – Text Mode tool bar button or choose it from the 
Edit menu.  Select the One Slot tab to schedule an event that happens once 
per week. Select the Daily tab if you want the event to occur on more than 
one day per week. Select the Range tab for something that occurs hourly 
during the day. 

Make changes to existing events 
You should edit like timeslots together. That is, edit all of the call to worship 
(Mass) times, then the Angelus times.  

1. Right click in the schedule list and select View slots with selections. 
2. Click line by line in the main viewing window to highlight timeslots.  Hold 

the control key while clicking with the mouse to combine your choices if 
they are not consecutive in the list. If they are consecutive, you can drag a 
selection box around them. 

3. Click the Change Timeslot(s) – Text Mode button.  A new window will pop up 
with tabbed panels that can be used to select timeslots and make changes.  
Use the Selected tab to edit the existing timeslots you have selected above. 
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Graphical Editing 

 
Editing the Time Strikes in Graphic Mode. 

Time strike options can easily be set in the graphic edit mode.  

Click the Change Timeslot(s) – Graphic Mode button. This window represents 
each quarter hour of the week as cells of a grid.  

White cells have the time strike turned off. The CHM (chime melody) mode 
is programmed in those time slots whose cells are colored light blue and have 
a musical note at the top of the cell. The STK (strike only) mode is 
programmed in those time slots colored yellow with a hammer at the top of 
the cell. These options are detailed below. 

Selected cells change to red when they are ready to edit. To select the times 
you wish to edit in Graphic Mode, you may click single or multiple cells while 
holding [Ctrl] on the keyboard. You can click and drag a rectangular selection 
box around multiple cells to select a range of days and times.  

Quarter-hour selection check boxes at the top of the window enable or 
prevent quarters of the hour from being changed. This allows you to modify 
only the top of the hour, or top and half for a selected range of time. Use the 
pull down menu to select the level or style of time striking and then click the 
Change Selected Timeslots button to modify the selected cells. 
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After making changes you can deselect all selected times by clicking in the 
areas to the left or right of the grid or beginning a new selection without 
holding the Ctrl key. 

Time Strike Options 
When CHM is selected, the clock-chime melody (Westminster Chime) plays 
on the selected quarter hour(s) and will be followed at the top of the hour 
with a toll of the hour.  When STK is selected, the top of each hour is 
marked only with a toll of the hour, and all other quarters are marked by a 
single strike. When OFF is selected, no time announcement shall be rung for 
that particular quarter-hour.  

For example, it may be desirable that the Westminster melody and time strike 
be used every quarter-hour throughout the day, and at night, only have the 
top and bottom of each hour tolled to minimize noise in the community. 

Transferring Data to/from the Bell System 

Get Titles from Device 
Generally you only need to do this once. After that, the Scheduler and 
jukebox functions will remember the titles available. Click the Get Titles from 
Device tool bar button or choose it under the Device menu.  You will be 
prompted to confirm; click OK.   

After a moment a new window will be generated, displaying the available 
library selections. These are some of the most used special ringing functions 
stored in the system memory. Refer to the bell system operating manual for 
additional selections. 

The Show Device Titles tool bar button is used to view this library once it is 
downloaded. This feature is a useful tool when composing your schedule, to 
look up numbers for popular ringing codes and options. You can use copy 
(ctrl-c) and paste (ctrl-v) to put these numbers into your schedule editing 
fields. 

Uploading Schedules to the Bell System 
As you are composing a new schedule, it is a good idea to save the file 
periodically.  When it is finished, it might be a good idea to double check 
codes and settings and look over the Graphic view. 
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Connect the controller to your personal computer. Open the Management 
Suite software.  Notice whether it indicates “Not Connected” or “Ready.” 

1. Click on the Scheduler. 
2. Open the schedule you wish to load from where it was saved. 
3. If the system is playing, wait for it to finish, or press the [Cancel] button 

twice to cause it to stop and return to the standby mode. 
4. The schedule you wish to load must currently be in view. If multiple 

schedules are open in the scheduler, click on the tab of the schedule you 
want to load. 

5. Click on the Put Schedule into Device button on the toolbar.   
6. One of the following panels will open.  

 
Free Management Schedule Storage confirmation – click OK 

 

 
Premium Management Schedule Storage window 
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7. Premium Management Suite Only To store the schedule into active 
memory (the current weekly schedule), click Put Schedule in Device at 
the top of the window. Alternately save the schedule in FLASH 
memory so it can be made active later when a macro selection code is 
executed. The macro selection number is displayed to the right of 
each Store Schedule to Macro button. The file names of previously 
stored schedules are listed to the left of programmed macro storage 
buttons.  

8. Premium Management Suite Only You can remove schedules from 
macros by selecting the check boxes on the left side of the Storage 
window and click the button at the lower left of the window. You do 
not have to clear macros before replacing them with new schedules. 

Managing Multiple Weekly Schedules 
Full Management Suite Only 

Up to ten weekly schedules can be stored in FLASH memory to be 
transferred to active schedule memory when the associated macro code is 
executed. The macro code can be programmed anywhere a selection number 
is normally entered. It is generally not a good idea to place these schedule 
activation codes in a weekly schedule unless it is a temporary schedule and 
you want to replace it with a default later in the week. 

Typically you will have a schedule for various times of the year. The one-time 
or annual event schedules are the logical place to program the schedule 
transfer macros at the appropriate time. The macro codes are 7930 – 7939.  

Any edits made to the active schedule either from the system front panel 
editing screen or with the Scheduler application will not affect the copy in 
FLASH memory. The next time a macro overwrites active memory, changes 
will be lost if they are not saved with the Scheduler application. No provision 
is made to transfer a schedule to FLASH except with the Scheduler 
application. 

Get Schedule from Device 
Click the Get Schedule from Device tool bar button or choose it under the 
Device menu.  You will be prompted to confirm or choose to retrieve a macro 
schedule. A new window will display the current schedule.  
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SPECIAL EVENT PROGRAMMING 
Premium Management Suite Only 

Special events are times you want the system to play automatically, but not on 
a weekly basis. Ringing for a special service that will not be repeated can be 
programmed in advance. Annual or One Time events can also be used to 
execute macros to transfer weekly schedules from FLASH memory to active 
memory. 

Events programmed at the same time will occur in the order they occur in the 
list. The list can be sorted by either double clicking the column headings or 
selecting events and pressing [Ctrl]+[cursor Up] or [Ctrl]+[cursor Down] keys.  

Annual Events 
A typical annual event is defined by a month, date, time and a selection 
number. In addition to hard dates, you can also define a day in the first, 
second, third, fourth or last week of the month.  

One-Time Events 
Any selection can be programmed to play once for special events or 
memorials. One-time events are programmed exactly like the annual events 
with the addition of an input field for the year. 
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JUKEBOX 
Although the Jukebox is of limited value to bell control systems, it can be 
used to audition the various ringing options, so we provide it for your 
convenience. The Jukebox lets you create and save play lists that can be used 
for special events and concerts. It is much more flexible than the controller’s 
built-in manual mode. 

Connect the bell control system unit to your computer, and then open the 
Management Suite program.  Note whether “Ready” status is indicated.  Click 
the Jukebox button to open this feature. If the controller is not ready, either 
wait for the automatic operation to finish, or open the Remote Control panel to 
cancel the current operation. 

 
 

Jukebox, ready to make a Play list. 
 

If the right pane in the Jukebox window is empty, you need to get the library 
listing controller unit.  Go to Titles - Get Titles from Device or click the button 
on the tool bar.  It should display the list momentarily. Familiarize yourself 
with the menus and available options. Context menus for each pane are 
available with a right mouse click. 
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Building a Play List 

A play list must be created before special functions can be played by Jukebox.  
You can save play lists for different occasions in separate files. 

Adding Selections 
Once a desired title is found, you may simply drag-and-drop the number into 
your play list from the current title list.  Copy and Paste can also be used by 
right mouse clicking in the appropriate list, using the toolbar buttons, Edit 
menu, or [Ctrl+C] (copy) and [Ctrl+V] (paste) on your keyboard.  Keep in 
mind that multiple selections can be highlighted before bringing into the play 
list window by using [Ctrl] and/or [Shift]. 

Note that only the selection numbers are highlighted when selections are 
marked. Selections can be repeated in the play list any number of times. 

Moving and Deleting 
Selections can be added to the play list in any order.  Re-order the play list 
using the Move Selections Up and Move Selections Down buttons.  Another easy 
method is to use [Ctrl] and/or [Shift] to highlight selections, and then click 
and hold left-mouse while dragging to any position on the list where you wish 
to drop them.  Selections will be grouped together in one block, in the same 
order they first appeared.  Note, however, that the move up and down 
commands keep the original number of “gaps” between multiple, spaced 
apart selections when moving, whereas dragging with the mouse lumps them 
together. 

Another way to change the order is to double click the column headings to 
sort by selection number or title. Re-ordering in this way does not flag the file 
for saving (by putting an asterisk next to the file name). You must 
intentionally save the sort order if you want to keep it. 

The delete function (“X”) will take any and all selected titles off of the 
currently open play list.  There is no undo for deletions. 

Create Title 
There may be cases when you wish to rename a selection to something more 
familiar or create a personalized description.  The selection will usually need 
to be an existing entry from your Device Titles list. Click on Create Title in 
the toolbar, enter the appropriate code number, enter your new title.  
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Depending on the model and customization of your controller, it is possible 
to obtain selection numbers that are not listed under Device Titles. 

Play Menu and Options 

The three play controls are Play, Next Selection and Cancel All. You can also 
start playing the playlist from the bell system remote control if the playlist is 
displayed in the active Jukebox window. 

Play Mode 
Pull down your choice of All or Selected.  For the latter, if you wish to only 
play certain selections from the chosen play list hold [Ctrl] and/or [Shift] on 
your keyboard to help highlight the selection numbers you want to play.  
Note that if Play Mode – Selected is active, but no selection numbers are 
marked, clicking Play will have no result. 

Selection Advance, Stop, and Closing 
The Advance button is clicked to cancel the current selection being played and 
begin playing the next selection. To cancel the entire concert, click the Stop 
button. 

If you close the Jukebox window during playback the concert will conclude 
after the current selection has completed.  

Remote Activation 
When a playlist is open in the active window, the PLAY button on the remote 
control will activate the current play mode. Pressing the STOP button once 
will cancel the current selection and begin playing the next selection. Pressing 
the STOP button to cancel the current selection, then pressing immediately 
again will cancel the remainder of the play list. 

Viewing Options 
Full screen mode can be selected from the View menu and serves as a large 
sign for passerby to see what is being played in a kiosk situation. This screen is 
customizable from the ChangeFullScreen panel of the View menu. Right-click to 
exit full screen mode or press [Esc] on your keyboard. 
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REMOTE CONTROL 
This feature of the Management Suite looks and operates very similar to the 
front panel of your controller.  The keypad operates the same, and the display 
will show exactly what appears on the control head. You can operate the bell 
system when sitting at your computer, out of reach of the device. If you can 
remote into your computer you can control your bells from anywhere in the 
world. 

Click the Remote Control button on the main menu to open the remote 
panel shown below. Refer to the bell control system operating manual for 
operational features and menus.  

 
Remote Control works as if you are in front of the control head. 
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An alternative to mouse-clicking buttons in the Remote Control is to use your 
computer keyboard.  Refer to the following table for these shortcuts: 

 

Remote Control - Computer Keyboard Shortcuts

Controller Keypad button PC Keyboard button

0 0 

1 1, F1 

2 2, F2 

3 3, F3 

4 4, F4 

5 5 

6 6 

7 7 

8 8 

9 9 

Cancel/Stop Esc 

Enter/Play Enter/Return 

Cursor         

 End (to Exit) 

 
Control from Anywhere 
Splashtop.com, GotoMyPC.com and LogMeIn.com are resources for remote 
control software that allow you to control the carillon from other computers 
and mobile devices. 

 You can customize the button sizes for fitting your touch-screen, PDA or 
smart phone that you use to remote into your system. Use the Button Size and 
Button Layout options under the View menu to arrange the buttons to fit your 
screen. 
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UPDATE FIRMWARE 
This feature is used to update the firmware in your Carillon unit. The latest 
standard firmware is included with each release of the Management Suite 
software. 

If customized features have been installed on your system, or foreign language 
support, these features may be lost if you update your firmware with the 
standard firmware supplied. Call if you are not sure if you need to update. 

After launching the update application, click the Update button in the 
window. All of the update files that are applicable to your system will be 
displayed. The last four digits indicate the revision number and year of release 
in the format RNYY. Use the highest revision number of the most recent year 
when you select the file. 

If we email the firmware update file to you, save the attachment to your 
desktop, and then drag it into the Open file dialog windows so you can select 
it. 

UPDATE LIBRARY 
Instructions for updating your library will be supplied along with library 
update files. 

If a library file is emailed to you, the easiest way to get it into the 
proper folder for the Management Suite is to click on the Update 
Library button, then drag the files into the file dialog screen. 
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BACKUP 
You can perform various backups of important files and settings using this 
feature. 

 
 

Schedules and setup data can be backed up all at once or into separate 
backup files. 
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